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INTRODUCTION

This runbook defines the pre-onboarding build for Windows workstations at StackFull
Software. Its purpose is to take a fresh client from “workgroup and unknown” to a managed,
compliant, and ready-for-day-one state—joined to the contoso.com domain, governed by
baseline security policy, and provisioned with the resources a new hire needs. The procedures
standardize setup, reduce lead time for IT, and cut risk by enforcing least-privilege access and
auditable controls from the first login.

The workflow implements four pillars of control:

1.

Identity & Join: Bind the device to Active Directory, place it in the correct OU
(HR_OU), and ensure the right user (Jordan Smaih / jsmaih) and group
(HR_Department) relationships exist.

Access & Data: Publish a departmental share (HRShare) with aligned share + NTFS
permissions (read/write for HR only), and auto-map it at logon.

Policy & Hardening: Apply a GPO (HR_Policies) that shows an interactive logon
banner, blocks CMD for users, removes Run, and maps the H: drive—delivering
consistent posture with minimal manual touch.

Audit & Evidence: Validate logons in Event Viewer (4624), confirm installed software
and running services via PowerShell, and capture screenshots as evidence.

Scope & Outcomes

After completing this runbook, the target workstation will:

Be joined to contoso.com and located in HR_OU with the correct security scope.
Enforce baseline user restrictions (no CMD, Run removed) and display the standard legal
banner.

Map H: to \\172.31.42.153\HRShare for HR staff with appropriate write access.
Produce verifiable artifacts: Security log entries (ID 4624), “latest installed program”
output, and running services.txt.

Assumptions & Prerequisites

Domain Controller/DNS: 172.31.42.153 (AD DS + DNS healthy; server uses itself as
DNS).

Domain: contoso.com; admin credentials available (Administrator / Pa$$wOrd for
lab).

Client: Windows desktop with IPv4 Preferred DNS set to the DC IP.

You have rights to create users, groups, OUs, shares, and GPOs in the lab.
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Evidence & Documentation

Each major step includes a screenshot placeholder. Capture evidence on the client and server as
indicated (join confirmations, GPO links, drive map, policy effects, Event Viewer 4624,
PowerShell outputs). These artifacts demonstrate control ownership and are suitable for audit or
peer review.

ENVIRONMENT SUMMARY

¢ Domain: contoso.com

e Domain Controller/DNS IP: 172.31.42.153

e Admin credentials used to join domain: administrator / PaSSwOrd
e Client: Desktop-1 (Windows)

STEP O — FIX: POINT CLIENT DNS TO THE DOMAIN CONTROLLER

Windows domain join requires the client to use the Domain Controller (DC) as DNS so it can
resolve the domain and locate AD services.

PROCEDURE (DESKTOP-1)

1. Open Control Panel - Network and Sharing Center - Change adapter settings.

2. Right-click the active adapter - Properties = select Internet Protocol Version 4
(TCP/IPv4) - Properties.

3. Select “Use the following DNS server addresses” and set Preferred DNS to
172.31.42.153.

4. Click OK to apply.

Figure 1: Client DNS set to the Domain Controller (172.31.42.153) on Desktop-1.

Internet Protocol Version 4 (TCP/IPv4) Properties X

General  lternate Configuration

You can get IP settings assigned automatically if your network supports
this capabilty, ed to ask your network administrator

@ Obtain an IP add
(O Use the following 1P address:

(O Obtain DN server address automatically
Install Uninstal — (@ Use the following DNS server addresses:

Preferred DNS server: 172,31 . 42 .153

in Control Protocol/Intemet Protocol. The default Alternate DNS server:
k protocol that provides commurication
terconnected networks.

[validate settings upon exit Advanced...
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STEP 1 — VERIFY CONNECTIVITY & NAME RESOLUTION

COMMANDS EXECUTED (REFERENCE)
e ping 172.31.42.153
* nslookup contoso.com

EXPECTED RESULTS
e ping replies from 172.31.42.153 (0% loss acceptable).
e nslookup contoso.com resolves to the DC/DNS and shows the DC as the Server.

E¥ Windows PowerShell - O X

owerShell
icrosoft Corporation. All right

ec » Los
imes in milli-

= b

Figure 2: Connectivity and name resolution successful (ping to DC and nslookup contoso.com).

STEP 2 — JOIN DESKTOP-1 TO THE DOMAIN

PROCEDURE (DESKTOP-1)

1. Right-click This PC = Properties - Advanced system settings - Computer Name -
Change.

2. Under “Member of,” choose Domain and enter: contoso.com

3. When prompted, provide domain admin credentials:
— Username: administrator
— Password: PaS$wOrd

4. Accept the confirmation dialog and restart when prompted.
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Computer Name  Hardware Advanced System Protection Remote

L

on the network.
‘You can change the name and the membership of this
Computer description: computer. Changes might affect access to network resources.
For example: "Kitchen Computer” or "Mary's
i Computer".
Full computer name: Desktop-1 Computer name:
Workgroup: VIORKGROUP [Desktop-1
Full computer name:
To use a wizard to join a domain or workgroup, click Network 1D Desktop-1
Network 1D.
More...
To rename this computer or change its domain or
workgroup, click Change. S Member of
(®) Domain:
|corrtoso.corr||
() Workgroup:
WORKGROUP

Windows uses the following information to identify your computer

Computer

0K

Computer Name  Hardware Advanced System Protection

L2

on the network.

Computer description:

Full computer name:

Workgroup:

To use a wizard to join a d
Network |D.

To rename this computer or change its domain or

workgroup, click Change.

Remote

Windows uses the following information to identify your computer

For example: "Kitchen Computer” or "Mary's
Computer”.

Desktop-1
WORKGROUP

lomain or workgroup., click Network 1D...

0K Cancel Apply

X

Name/Domain Changes

‘You can change the name and the membership of this
computer. Changes might affect access to network resources.

Computer name:

Desktop-1

Full computer name:
Desktop-1

Member of
(® Domain:

Computer Name/Domain Changes

o ‘Welcome to the contoso.com domain.

contoso.com

(O Workgroup:

WORKGROUP

Cancel

Figure 4: Success dialog — “Welcome to the contoso.com domain.”
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NOTES & TROUBLESHOOTING

e If you see “An Active Directory Domain Controller for the domain could not be contacted,” re-
check:

— Client DNS points to the DC (not public DNS).

— Network connectivity to the DC (same network/segment, no firewall blocking).

—The DC is running AD DS and DNS services.

STEP 3 — CREATE DEPARTMENT GROUP AND ADD THE NEW HIRE

GOAL
Create a Global Security group for the department and add the new-hire account to it.

3.0 CREATE THE NEW-HIRE USER (SERVER)

Server Manager = Tools = Active Directory Users and Computers (ADUC).

Expand contoso.com = Users.

Right-click Users - New - User.

Fill in:

— First name: Jordan

— Last name: Smith

— User logon name (UPN): jsmith@contoso.com

— (sAMAccountName should be jsmith)

5. Password: PaSSword123 (you may uncheck “User must change password at next logon”
for lab).

6. Finish. Verify the account exists in Users.

PwnNnpE

; New Object - User X
12
= Createin:  contoso.com/Users r
= U i|
1
~
First name: ordan] l Initials: ‘ ‘ "
1
Last name: lSm'rth ‘
r
Full name: ‘Jordan Smith ‘ b
b
User logon name:
|iSfT1'rth | @contoso.com ~ b
il
User logon name (pre-Windows 2000):
[conToson | [smith | b
b
r
Back Cancel | [
r
< >

Figure 5: New user wizard — Jordan Smith (jsmith) created in ADUC.
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3.1 CREATE THE DEPARTMENT GROUP (SERVER)

bk wnN e

In contoso.com = Users, right-click - New - Group.
Group name: HR_Department

Group scope: Global

Group type: Security

OK.

O 0 ( ?

& Server Manag| T Active Directory Users and Computers - o x

e File Action View Help
e FE 0 XD HEPeaTa%

[ Active Directory Users and Com|| Name Type Description
NS > [] Saved Queries 7 Builtin builtinDomain
= [¥%i[contoso-cor | Computers Container Defautt container for up...
0 Local Se
- =] Domain Contro... Organizational... Default container for do...
Wi All Servey I ForeignSecurity... Container Default container for sec...
T§l AD DS “I Managed Servic... Container Default container for ma...
[ | Us o — <20t container for up... |

2 DNS P — &
g Fileand Find...
oIS Computer New B

Contact All Tasks >

ST Properties

InetOrgPerson

msDS-KeyCredential Help

msDS-ResourcePropertyList

msDS-ShadowPrincipalContainer

mslmaging-PSPs

MSMQ Queue Alias

RVER GROUPS
Printer & -
groups: 1 | Servers total:
User
Shared Folder ‘ ‘ =pm File and Stc
- 1 & DNS 1 "

Figure 6: HR_Department Global Security group created under Users

3.2 ADD THE NEW HIRE TO HR_DEPARTMENT (SERVER)

PwnNpE

HR_Department - Properties > Members - Add...
Locations... = contoso.com; Object Types... includes Users.
Enter jsmith (or contoso\jsmith) - Check Names - OK.
Confirm Jordan Smith (jsmith) appears = Apply = OK.
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: Active Directory Users and

File Action View Help

e am 4aly

] Active Directory Users and C|
| Saved Queries

v 3 contoso.com

Builtin

Computers

(!

Domain Controllers
ForeignSecurityPrinci
Managed Service Acg

=
=
> I
(o
| Users

Figure 7: HR_Department — Members tab showing Jordan Smith (jsmith) added.

J HR_Department Properties

Select Users, Contacts, Computers, Service Accounts, or Groups X
Select this object type:

‘ Users, Service Accounts, Groups, or Other objects | Object Types...
From this location:

[con‘toso.com | Locations. ..
Enterthe object names to select (examples):

Jordan Smith (smith@contoso.com Check Names

‘7 Advanced... Cancel

Add... Remove

3.3 VERIFY MEMBERSHIP ON THE USER OBJECT (SERVER)

1. Right-click Jordan Smith = Properties - Member Of.
2. Confirm HR_Department is listed.

] Active Directory Users and

File Action View Help

LL Ak R=1k,
] Active Directory Users and C
» [ ] Saved Queries
v [ contoso.com
» [ Builtin
[ Computers
» 2. Domain Controllers
» || ForeignSecurityPrinci
» ] Managed Service Acc
| Users

Figure 8: Jordan Smith — Member Of tab includes HR_Department

HR_Department Properties

Select Users, Contacts, Computers, Service Accounts, or Groups X

Select this object type:

‘USBTS. Service Accounts, Groups, or Other objects | ‘ Object Types...

From this location:

‘comoso.com | ‘ Locations...

Enter the object names to select (sxamples):

Jordan Smith {smith@contoso.com; ‘ Check Names

| Advanced.._ | Cancel
 Add.. Remove
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STEP 4 — CREATE A DEPARTMENT SHARE WITH READ/WRITE (HR)

GOAL
Create a departmental network share for HR that only members of HR_Department can
read/write, and add a seed file test.txt.

WHERE
Server (Domain Controller)

4.1 CREATE THE FOLDER STRUCTURE

1. File Explorer = create C:\Shares\HR.

I [ [ = | Shares - o X
Home Share View (]
« vt v|@| | Ssearch Shares P
Neme - Date modified Type Size

s Quick access

M Deskiop HR 8/17/20251:34 AM  File folder

& Downloads

[E] Documents

&=] Pictures

System32

I This PC

[ Desktop

[£ Documents

¥ Downloads

D Music

=] Pictures

& Videos

i, Local Disk (C:)
¥ Network

Titem E=

Figure 9: Department folder created at C:\Shares\HR on the server

4.2 SET NTFS (SECURITY) PERMISSIONS

1. Right-click C:\Shares\HR - Properties = Security = Edit.

Remove broad principals you don’t want (e.g., Users if present).

3. Add CONTOSO\HR_Department with Modify, Read & execute, List folder contents,
Read, Write (i.e., Modify).

4. Ensure Administrators and SYSTEM retain Full control. Apply - OK.

N

10
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ne
HR Properties [

Permissions for HR X
Security
Object name:  C:\Shares\HR

Group or user names:

H& CREATOR OWNER

SR SYSTEM

Td a fstack

H2 Administrators (CONTOSO \Administrators)
- 4 Users (CONTOSO \Users)

Add... Remave

Pemissions for Users Allow
Full control O
Modify O

Fo Read & execute

cli List folder contents

Read

DDDDDg

ok ][ canee Apply
-

Figure 10: NTFS permissions — HR_Department has Modify; Administrators/SYSTEM have Full control.

4.3 PUBLISH THE SMB SHARE (SHARE PERMISSIONS)

1. C:\Shares\HR = Properties = Sharing - Advanced Sharing.

Check “Share this folder”; Share name: HRShare.

3. Permissions: Remove Everyone; Add CONTOSO\HR_Department with Change and Read
(no Full Control).

4. OK all dialogs.

N

HR Properties

Permissions for HRShare X

Share Permissions

Group or user names:

SR Everyone
_ 4HR_Department (CONTOSO\HR_Department)
Add Remove
Pemissions for HR_Department Allow Deny
Full Cortrol O O
Change O
Read O
- oot [ |

Figure 11: Sharing tab — HRShare created for C:\Shares\HR.

11
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HR Properties

Permissions for HRShare

Share Permissions

GI’OUD 0or user names:

_ YHR_Department (CONTOSO\HR_Department)

Add.. Remove
Permissions for HR_D it Allow Deny
Full Control | O
Change O
Read O
Cancel Apply

Figure 12: Figure 4.4: Share permissions — only HR_Department with Change + Read (no Everyone).

4.4 CREATE SEED FILE FOR LATER VALIDATION

1. Open C:\Shares\HR.
2. New = Text Document = test.txt.
3. Add aone-liner (e.g., “HR seed file”) and save.

!
Home

€ o ovn

3 Quick access
[ Desktop
4 Downloads
Documents
[&] Pictures

System32

8 This PC

[ Desktop
E] Documents
‘ Downloads
Jﬁ Music

[&] Pictures

E Videos

‘i Local Disk (C:)

=¥ Network

= | HR

Share

View
» ThisPC » Local Disk (C) » Shares » HR

Name

5] testnt

L N

Date modified

8/17/2025 1:45 AM

Type Size

Text Document

Figure 13: test.txt created inside C:\Shares\HR.

1KB

12
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4.5 VERIFY THE SHARE IS PUBLISHED (COMPUTER MANAGEMENT MMC)

1. Server Manager - Tools - Computer Management.
2. System Tools = Shared Folders = Shares.
3. Confirm HRShare - Local Path shows C:\Shares\HR.

& Computer Management - o x

<al | ShareName  Folder Path Type # Client Connections
2 ADMINS CA\Windows Windows
EaCs = Wi

i
z
~ v

& IPCS Window:
1 NETLOGON  C:\Windows\SYSV...  Windows
EISYSVOL  C:AWindows\SYSV... Windows
] Users Ci\Users Windows

: ment
s Services and Applications

Figure 14: Computer Management — Shared Folders - Shares shows HRShare - C:\Shares\HR.

STEP 5 — CREATE AN OU AND LINK A GPO

Goal
Create an Organizational Unit (OU) for the department, move the user, group, and computer
into it, and link a new GPO that we’ll configure in Step 6.

Where
Server (Domain Controller)

5.1 Create the OU

1. Open Active Directory Users and Computers (ADUC)
o Server Manager - Tools - Active Directory Users and Computers

2. In the left pane, right-click the domain contoso.com - New - Organizational Unit.
3. Name: HR_OU

4. Leave “Protect container from accidental deletion” checked (recommended).

5. Click OK.

13
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File Action View Help

] Active Directory Users and Computers

e nE B XEBeR Bl PaaTa%

] Active Directory Users and Com
“| Saved Queries
v i contoso.com
_| Builtin
~| Computers
Domain Controllers

Managed Service Accour|
Users
HR_OU

20 s e Lo [

ForeignSecurityPrincipaly| .

Name Type Description

[ Builtin builtinDomain

1 Computers Container Default container for up...

[=] Domain Contro... Organizational.. Default container for do...

[ ForeignSecurity... Container Default container for sec...

[ Managed Servic... Container Default container for ma...
I Users Container Default container for up...

E |HR_ OU Organizational...

Figure 15: HR_OU created under the contoso.com domain in ADUC.

We previously created:

User: Jordan Smith (jsmith) — currently under Users
Group: HR_Department — currently under Users
Computer: DESKTOP-1 — typically under Computers

Move via ADUC (drag-and-drop):

1.

3.

In ADUC, expand contoso.com and select the source containers:

o Users (for jsmith and HR_Department)
o Computers (for DESKTOP-1)
2. Drag each object into HR_OU.

If you see an error like “Access is denied”, right-click the object - Properties - Object
tab = uncheck “Protect object from accidental deletion,” then move again.

14
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] Active Directory Users and Computers - m] X
File Action View Help
e 1@ S0/ XE2 BHE 3 aaTER
[ Active Directory Users and Com|| Name Type Description
=] Saved Queries ? Jordan Smith  User
v & contoso.com 18I DESKTOP-1 Computer
~| Builtin
| Computers
2 | Domain Controllers
_| ForeignSecurityPrincipal
| Managed Service Accour|
| Users
1 HR.OU
< >

Figure 16: HR_OU containing the user (jsmith), group (HR_Department), and computer (DESKTOP-1).

5.3 Create and Link a GPO to the OU

We’'ll only create and link the GPO here. We'll edit the GPO policies in Step 6.
Open Group Policy Management (GPMC):

e Server Manager - Tools > Group Policy Management (or run gpmc.msc)
Create & Link:

In the left pane of GPMC, expand Forest: contoso.com - Domains - contoso.com.
Right-click HR_ou - “Create a GPO in this domain, and Link it here...”

Name: HR_Policies - OK

Confirm HR_Policies now appears linked under HR_OU.

PwnNe

15
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|, Group Policy Management - ] X
2 File Action View Window Help - &
= 2@ X6 HE
(5L Group Pelicy Management HR_Policies
v S\S Forest: contoso.com Scope Details Settings Delegation

v (&5 Domains _
v 3 contoso.com Links
5] Default Domain Policy Display links in this location: contoso.com “
3| Domain Controllers The following sites, domains, and OUs are linked to this GPO:
v (2] HR_OU oy
=] HR_Policies Location Enforced Li
5 Group Policy Objects [EIHR_OU No e
- WMI Filters
3 Starter GPOs < >
[ Sites Security Filteri I
;¢ Group Policy Modeling y Hitering
- % Group Policy Results The settings in this GPO can only apply to the following groups, users, al
Name -
52 Autherticated Users
< >

Figure 17: GPMC showing HR_Policies linked to HR_OU.

STEP 6 — EDIT THE HR_Policies GPO AND APPLY RULES

Goal
Configure the GPO linked to HR_OU to:

Show a startup/logon message (“Do not install unauthorized programs.”)
Block Command Prompt (CMD) for users

Map the HR share at user logon

Remove the Run command from Start

PwnNpE

Where
Server (Domain Controller) — Group Policy Management (gpmc.msc)

Scope Reminder

e HR_Policies must be linked to HR_OU
e User (jsmith) and computer (DESKTOP-1) should be inside HR_OU (done in Step 5)
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6.1 Configure the Logon Banner (Startup Message)

Path
Computer Configuration - Policies - Windows Settings - Security Settings - Local Policies - Security Options

Settings

¢ Interactive logon: Message title for users attempting to log on - Enabled
o Title: Notice

¢ Interactive logon: Message text for users attempting to log on - Enabled
o Text: Do not install unauthorized programs.

Actions

1. Right-click HR_Policies = Edit
2. Navigate to the path above
3. Set Title and Message text as specified - OK

=] Group Policy Management Editor - [m] X
File Action View Help

e @ XE = HE
v (& Computer Configuration A || policy ~ Policy Setting "
w [ Policies

. lz) Domain controller: Refuse machine account password chan... Mot Defined
| Software Settings

v [ Windows Settings
| Name Resolut|

[ Scripts (Startu

= Deployed Prin

s/ Domain member: Digitally encrypt or sign secure channel d... Not Defined
12y Domain member: Digitally encrypt secure channel data (wh... Not Defined
2, Domain member: Digitally sign secure channel data (when ... Not Defined
[y Domain member: Disable machine account password chan... Not Defined

« a Security Settir| || L Domain member: Maximum machine sccount password age - Not Defined
33 Account P iZs) Domain member: Require strong (Windows 2000 or later) se... Not Defined
v :a Local Polic 12 Interactive logon: Display user information when the session... Not Defined
3 Audith i1 Interactive logen: Do not display last user name Not Defined
;ﬁ User Ri iy Interactive logon: Do not require CTRL+ALT+DEL Not Defined
3 Securit| ||| [ Interactive logon: Don't display username at sign-in Not Defined
| Eventlog 12| Interactive logon: Machine account lockout threshold Not Defined
4 Restricted 5] Interactive logon: Machine inactivity limit Mot Defined
A System Se ] Interactive logon: Message text for users attempting to log on Do Not Install unauthorized programs.
'3 Registry 4y Interactive logon: Message title for users attempting to log on  Notice
" File Systen” || [} Interactive logon: Number of previous logons to cache (in c... Not Defined
28 Wired Net || |1/ nteractive logon: Prompt user to change password before e... Not Defined L
Bl Windows | 12y Interactive logon: Require Domain Controller authentication... Not Defined g
1 Metwork L . . .
ZoF Wireless N |1 Interactive logon: Require smart card Not Defined
o P I:,ES; i) Interactive logon: Smart card removal behavior Not Defined
— PUble RSy 1 12 Microsoft network client: Digitally sign communications (al... Not Defined
~| SoftwareF , . . - X . . X v
R Microsoft network client: Diaitallv sian communications (if ... Not Defined
< > < >

Figure 18: Security Options with Interactive logon title and text configured.
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6.2 Block Command Prompt (without breaking logon scripts)

Path

User Configuration - Policies - Administrative Templates - System
Policy

e Prevent access to the command prompt - Enabled
o Disable the command prompt script processing also? = No
(Keeps CMD blocked for users, but still allows any batch scripts that Group Policy
might run.)

Actions

1. Inthe same GPO Editor, navigate to the path above
2. Open Prevent access to the command prompt - set Enabled
3. Set “Disable the command prompt script processing also?” = No - OK

L= Group Policy Management Editor - O X
File Action View Help
e nm 2 EE T

5] HR_Policies [EC2aMAZ-L300U| [T g gem
v & Computer Configuration X
Policies Prevent access to the command Setting State ~
2 Preferences prompt | Group Policy
v % User Configuration Edit policy setting “| Internet Communication Management
~ [ Policies | Locale Services
“| Software Settings Requirements: 1 Legen

| Windows Settings || At least Windows 2000

v ] Administrative Temp|

7| Mitigation Options
“| Power Management

Description:
I Control Panel || Thig policy setting prevents users | Removable Storage Access
| Desktop from running the interactive | Scripts
I Network command prompt, Cmd.exe. This User Profiles
policy setting also determines - )
el 2111;6;%'&’21 whether batch files (cmd i) Download missing COM components Not configured
| Start Menu an and .bat) can run on the computer. =] Century interpretation for Year 2000 Not configured
- \5:,‘5‘:’" c 2] Restrict these programs from being launched from Help Not configured
= Windows Compd| If you enable this policy setting 2] Do not display the Getting Started welcome screen at logon  Not configured
7 All Settings and the user tries to open a = !
orefences command window, the system [] Custom User Interface Not configured
- displays a message explaining that [ [l At ae e R Enabled
a setting prevents the action. i) Prevent access to registry editing tools Not configured
Wyou disablethis polcy seting or Don't run specified Windows applications Nt configured
do ot configure i, users can run ] Run only specified Windows applications Not configured
Cmd.exe and batch files normally. 2] Windows Automatic Updates Not configured =
v
| Note: Do not orevent the 3 4
< > | Extended { Standard

Figure 19: Prevent access to the command prompt = Enabled; script processing = No.

6.3 — Map the HR share at user logon (Drive Maps, no scripts)

Where: Server - Group Policy Management -> HR_OU - HR_Policies - Edit

1. Inthe editor: User Configuration - Preferences > Windows Settings - Drive Maps
2. Right-pane: Right-click - New - Mapped Drive
3. Fill out:

o Action: Create
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Location: \\172.31.42.153\HRShare (use your server IP or name)

Drive Letter: H:

Reconnect: &4 (checked)

Label (optional): HR Share

4. Common tab: leave defaults (you can tick Run in logged-on user’s context if you like) >
OK.

o O O O

£J Group Policy Management Editor — O
file  Action View Help
p@‘&|n|m& H: Properties X

:[ HR_Policies [EC2ZAMAZ-L300U
+ i Computer Configuration

General  Common

| Policies
[ ] Preferences =§: Action: | Create ~
¢ % User Configuration Path
[ Policies Location: [W172.31.43.108 [l] e wWIT231.43.06
~ [ Preferences Reconnect: Label as: | HR. Share |
v [ Windows Settings Drive Letter
i) Applications
=2 Drive Maps (O Use first available, starting at: (@) Use: ‘g H A
Environment
3’3‘ Files
(3 Folders Connect as (optional)
Ini Files User name:
ﬂ' Registry Password: Confirm password: \
[#] Shortcuts
(=0 Control Panel Settn Hide/Show this drive Hide/Show all drives |
(® No change (® No change
(O Hide this drive (O Hide all drives
(O show this drive (O show all drives

Apply

>[4 Preferences i Extended A Standard

Figure 20: Drive Maps item showing H: - \\172.31.42.153\HRShare.

6.4 — Remove the “Run” command from Start

Where: Same GPO editor

1. User Configuration - Policies - Administrative Templates - Start Menu and Taskbar
2. Open Remove Run menu from Start Menu - set to Enabled - OK.
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& Remove Run menu from Start Menu m} X
E} Remove Run menu from Start Menu Dottty Next Setting
(O Not Configured Comment:
(® Enabled
(O Disabled

Supported on: [\windows Server 2012 R2, Windows 8.1, Windows RT 8.1, Windows Server 2008, ~

Windows Server 2003, Windows 7, Windows Vista, Windows XP, and Windows
Options: Help:
Allows you to remove the Run command from the Start menu, ~

Internet Explorer, and Task Manager.
If you enable this setting, the following changes occur:
(1) The Run command is removed from the Start menu.

(2) The New Task (Run) command is removed from Task
Manager.

(3) The user will be blocked from entering the following into the
Internet Explorer Address Bar:

--- A UNC path: \\<server>\<share>
---Accessing local drives: e.g., C:
--- Accessing local folders: e.g,, \temp>

Also, users with extended keyboards will no longer be able to
display the Run dialog box by pressing the Application key (the |,

Figure 21: Policy window showing Enabled.

Apply & test (client)

On DESKTOP-2:

1. Reboot (or sign out/in) and log in as CONTOSO\jsmaih.
2. Open File Explorer - confirm H: appears and opens the HR share.

3. Open Start - confirm Run is gone (Win+R may also be blocked, depending on build).

Screenshots to grab (client):

Explorer with H: mapped to \\172.31.42.153\HRShare

Start menu with Run missing

EEp...

Il's...

ell...

STEP 7 — FIND THE LAST SUCCESSFUL LOGON FOR YOUR USER (ON THE
SERVER)

Goal

On the Domain Controller, find the latest successful logon event for your user (e.g., jsmaih) and
record the details.
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Sign in as

CONTOSO\Administrator (domain admin)

7.1 Open the Security log

1. Onthe server: Start - type “Event Viewer” - open.
2. In the left pane, expand Windows Logs - Security.

{3] Event Viewer

File Action View Help
|5

{2] Event Viewer (Local)
[ Custom Views

v [m Windows Logs
fs] Application
£ Security
] Setup
f5] System
5] Forwarded Events

[ Applications and Services Lo

[} Subscriptions

Security Number of events: 61,084

Actions

Keywor... Date and Time Source ™
@, Audi... 8/18/2025 1:27:03 AM Micros..,
@, Audi... 8/18/20251:27:03 AM Micros...
@ Andi.. RAS/2075 1:97:03 AM Micros... ¥
< >
Event 4634, Microsoft Windows security X

General Details

Subiect:

Log Name:
Source:
Event ID:
Level:

User:
OpCode:

More Information:

An account was logged off.

Security

Microsoft Windows securil

4634
Information
N/A
Info

Event Log Online Help

>

Security -

= Open Saved Log...
¥ Create Custom View...
Import Custom View...

Clear Log...

-

Filter Current Log...

i@

Properties
Find...

OB

Save All Events As...

Attach a Task To this Log...

View »
|63 Refresh

Help »
Event 4634, Microsoft Windows security audi... &
D Event Properties

@ Attach Task To This Event...

Bz Copy 4

v

Figure 22: Event Viewer - Windows Logs —> Security.

7.2 Filter to successful logons (Event ID 4624)

1. In Security, click Filter Current Log... (right pane Actions).
2. In Event IDs, type: 4624

3. Click OK.
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@ P g x
General Detals — —
Security Number of events: 61,245 () New events available Actions
\n account was successfully logged on. ~ 7 Filtered: Log: Security; Levek Information; Source: ; Event ID: 4624, Number of events: 14,908 Securty 4 "
[Subject: .. Dateand Time Source  EventlD TaskC. A|@ O
oty 0 CIDED . 8/18/2025 14T03AM  Micros.. 4624 Logon Y
Account Name: -
Account Domain - 1872025 1:4003 AM 4624 Logon [
LogonD: 00 e /1872005 1:3935 AM 462 Logon o
= 4624 Logon S
Log Name: Security 0 4624 Logon !
Source: Microsoft Windows security Logged: 8/18/2025 1:41:03 AM 8/18/2025 1:39:35 AM 4624 Logon Cl..
Event D: 624 Task Category: Logon 8/18/2025 1:39:14 AM 4624 Logon B P
ey ronaion ferms | Aris . 818202513914AM  Micros 4624 Logon e
User: NA Computer:  ECPAMAZ-L AQLO0S L0 AM M == W s
OpCode: Info Event 4624, Microsoft Windows security auditing. x -
More Information: ~Event Log Online Help ‘General | e
ails  so.
[An account was successfully logged on. = View »
@ Re.
Copy. Close Isublect: A o
B Hep >
Log Name: Security
X i Eventd.. &
Source: Microsoft Windows security Logged: 81872025 1:41:03 AM
® Manageabi . . v r——

Events

Figure 23: Filter Current Log - Event IDs = 4624.

7.3 Find your specific user (fast)

1. With the filtered list visible, press Ctrl+F (or click Find... in Actions).

2.

O

In Find what, type your username: jsmaih - Find Next.
This jumps to the next 4624 (success logon) that contains jsmaih.

Tip: If it lands on an older one, click once in the middle pane and press Shift+F10 - Sort by -
Date and Time (or click the Date and Time column header) to get newest at top, then use Find
again.

& eve

Server Manager * Dashboard File Acton View Help
b | & I =:
{2 Event Properties - Event 4624, Microsoft Windows security auditing.
General Details
[An account was successfully logged on. ~
Subject:
Security ID: NULL SID
Account Name: -
Account Domain: -
Logon ID: %) v
Log Name: Security
Source: Microsoft Windows security Logged: 8/18/2025 1:37:46 AM
Event ID: 4624 Task Category: Logon
Level: Information Keywords: Audit Success
User: N/A Computer; EC2AMAZ-L300UG8.contoso.con
OpCode: Info

More Information: Event Log Online Help

Copy

pcurity  Number of events: 61,245 (!) New events available

7 Filtered: Log: Security; Level: Information; Source: ; Event ID: 4624. Number of events: 14,908
Eywor... Dateand Time Source  EventID TaskC.. o
Audi... 8/18/20251:39:35 AM Micros... 4624 Logon
Audi.. £/18/2025 1:39:35 AM Micros.. 4624 Logon
Audi... 8/18/20251:39:14 AM Micros... 4624 Logon
 Audi... 8/18/2025 1:30:14 AM Micros... 4624 Logon
\Audi... 8/18/2025 1:39:03 AM Micros.. 4624 Logon
. Audi... 8/18/20251:38:27 AM Micros... 4624 Logon
,Audi... 8/18/2025 1:38:03 AM Micros... 4624 Logon
Audi... §/18/2025 1:37:46 AM Micros... 4624 Logon
AudiR/18/2005 127:46 AN Mice 2624 Loaon 2
ent 4624, Microsoft Windows security auditing. x
General Details
~
[An account was successfully logged on. ~
Subiect: v
Log Name: Security
Source: Microsoft Windows security Logged: 8/18/2025 1:37:46 AM v

Events

Actions
Security

<

E]
=
H
T

4 Re..

Help »

Eventd...

B b

a

v

Figure 24: Find dialog searching for jsmith.
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7.4 Read the details you need

1. Double-click the matching 4624 event for jsmaih.

N

In the General tab, scroll to New Logon and Network Information sections.

3. Write down these fields (for your report):

o Time (top of the dialog)
New Logon - Account
New Logon - Account

O O O O O

e

H Event Properties - Event 4624, Microsoft Windows security auditing.

Genera | Details
New Logon: ~
Security ID: CONTOSO\jsmith
Account Name: jsmit)
Account Domain: CONTG50.COM
Logon ID: OQEE122
Linked Logon ID: 00
Network Account Name: - v
Log Name: Security
Source: Microsoft Windows security  Logged: 8/18/2025 1:37:46 AM
Event ID: 4624 Task Category: Logon
Level: Information Keywords:  Audit Success
User: N/A Computer: EC2ZAMAZ-L300UG8.conteso.con
OpCode: Info

More Information: Event Log Online Help

Name: jsmaih
Domain: CONTOSO

Logon Type: (e.g., 2 = console, 3 = network, 10 = RDP)
Network Information = Workstation Name (if present)
Network Information = Source Network Address (client IP, if present)

ecurity  Number of events: 61,245 (!) New events available

i’ Filtered: Log: Security; Level: Information; Source: ; Event ID: 4624. Number of events: 14,908

eywor... Dateand Time Source  EventID TaskC..
\ Audi... 8/18/20251:39:35 AM Micros.. 4624 Logon
R, A /18/2025 1:39:35 AM Micros.. 4624 Logon
A, A 025 1:39:14 AM Micros.. 4624 Logon
A 18/2025 1:39:14 AM Micros.. 4624 Logon
A, Audi... 8/18/20251:38:03 AM Micros.. 4624 Logon
18/2025 1:38:27 AM Micros.. 4624 Logon
LA 18/2025 1:38:03 AM Micros.. 4624 Logon
A, Audi... 8/18/20251:37:46 AM Micros.. 4624 Logon
L Audi £18/2005 1:37-46 AM Mices 4624 | nnon

vent 4624, Microsoft Windows security auditing.

General Details

[An account was successfully logged on.

Copy i Sublect:
Log Name: Security
Source: Microsoft Windows security Logged: 8/18/2025 1:37:46 AM
@ Manageability
< >
Events

Figure 25: Event 4624 details — New Logon and Network Information.

STEP 8

8.1 Open PowerShell

Actions
Security
< Opu
¥ Cr.

[E Pr.

[

Att...

T sa.

View
A Rew
H Help
Event 4.

B b

3

»

P

v

1. Click Start, type PowerShell, right-click Windows PowerShell -> Run as administrator.
2. Confirm the blue console opens.
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8.2 WMI

Command (type exactly):

Get-CimInstance Win32_Product | Sort-Object InstallDate -Descending | Select-
Object -First 1 Name,Version,Vendor,InstallDate

1 Name,Version,Vendor,InstallDate

Figure 26: PowerShell of Last Inatalled Package

Output:

PS C:\Users\jsmith> Get-CimInstance Win32_Product | Sort-Object InstallDate -Descending |
Select-Object -First 1 Name,Version,Vendor,InstallDate

Name Version Vendor InstallDate

Amazon SSM Agent 3.2.582.0 Amazon Web Services 20230211
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STEP 9 — List All Running Services to a File

Goal
Generate a list of all running Windows services and save it to running services.txt on the
signed-in user’s Desktop.

Where
Client workstation (e.g., DESKTOP-2) — Windows PowerShell

9.1 Run the command

1. Open Start — Windows PowerShell (normal window is fine).
2. Type the following single line and press Enter:

Get-Service | Where-Object Status -eq Running | Sort-Object DisplayName | Out-File
"Senv:USERPROFILE\Desktop\running_services.txt"

EX Windows PowerShell - a X

ct InstallDate | Select-Object 1 Name,Version,Vendor,InstallDate

Running | Sort-Object DisplayMName | Out-File “%en

Figure 27: PowerShell Script to List All Running Processes

25



StackFull Software — IT Pre-Onboarding Runbook

_| running_services - Notepad

File Edit

Status

Running
Running
Running
Running
Running
Running
Running
Running
Running
Running
Running
Running
Running
Running
Running
Running
Running
Running
Running
Running
Running

Running
Runnino

Format View Help

Name
AmazonSSMAgent
AppHostSvc
AppXSvc

BrokerInfrastru...

BFE

camsvc
CertPropSvc
cbdhsvc_12e58d
cbdhsve_lce2al
KeyIso
EventSystem
CDPSvc

CDPUserSvc_12e58d
CDPUserSvec_1lce2al

DiagTrack

PimIndexMainten...
CoreMessagingRe. ..

VaultSvc
CryptSvc
DusmSvc
DcomLaunch

dcvserver
NnSarr

- O

DisplayMame
Amazon SSM Agent
Application Host Helper Service
AppX Deployment Service (AppXSVC)
Background Tasks Infrastructure Ser...
Base Filtering Engine
Capability Access Manager Service
Certificate Propagation
Clipboard User Service_12e58d
Clipboard User Service_lce2al
CNG Key Isolation
COM+ Event System
Connected Devices Platform Service
Connected Devices Platform User Ser...
Connected Devices Platform User Ser...
Connected User Experiences and Tele...
Contact Data_lce2al
CoreMessaging
Credential Manager
Cryptographic Services
Data Usage
DCOM Server Process Launcher
DCV Server
Naliverv Nntimizatinn

Ln 50, Col 67 100%  Windows (CRLF) UTF-16 LE

Figure 28: running_services.txt
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